Experiment GB-3: Ecological
Balance

Background

The Earth is a closed ecosystem in which vital
elements and compounds like oxygen, carbon, nitrogen,
and water, are consumed and recycled through natural
processes.

An element and a compound that move through cycles
that are integrated with each other are carbon and water.
Carbon, in the form of carbon dioxide from the
atmosphere, and water are converted to sugars,
starches, and oxygen by plants that are undergoing
photosynthesis. In the next stage, the products of photo-
synthesis are consumed and utilized by animals to
provide energy for their life processes. Carbon, as
carbon dioxide, returns the atmosphere as animals
respire. Water returns to the environment together with
nitrogenous compounds through the decomposition of
waste products from animals.

The balance of the elements and compounds moving
through the cycles of synthesis and utilization is
essential to the health of the ecosystem. Changes in the
balance of the elements and compounds in the cycles
lead to changes in the ecosystem that could be irrepa-
rable if the change in the balance is large or sudden.
Species could be lost and biomes could be destroyed.

In this experiment, students will create an environment
into which a small aquatic animal, a goldfish, is intro-
duced. Students will measure the changes in the
dissolved oxygen concentration and the pH level of the
water in which the fish is respiring.

Students will also create an environment into which a
piece of aquatic plant is introduced. Students will
measure the changes in the dissolved oxygen concen-
tration and the pH level of the water when the plant is
exposed to light and photosynthesis takes place.

In the third exercise, the goldfish is reintroduced into
the environment containing the plant, and the changes in
the dissolved oxygen concentration and pH level of the
ecosystem are measured. It is also determined if the
ecosystem is more or less balanced than the other two
environments.
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Equipment Required
PC Computer
IWX/214 data acquisition unit
USB cable
IWX/214 power supply
ISE-730 Dissolved oxygen electrode
DO2-100 Current to voltage adapter
ISE-100 combination pH electrode
Magnetic stirrer
Stir bar
Ringstand
Utility clamps (2) for holding electrodes
Lamp with 75 watt bulb
100ml beakers (2)
250 ml beakers (3)
400 ml beaker
1000 ml beaker
Roll of plastic wrap
pH 4 and pH 7 buffer solutions
250 ml graduated cylinder
Thermometer
Pond water
Deionized water
Zero-percent oxygen calibration solution
Goldfish

6” branch of Elodea or similar aquatic plant

IWX/214 Setup
Place the IWX/214 on the bench, close to the computer.

Check Figure 1-1 in Chapter 1 for the location of the USB
port and the power socket on the IWX/214.

Use the USB cable to connect the computer to the USB port
on the rear panel of the IWX/214.

Plug the power supply for the IWX/214 into the electrical
outlet. Insert the plug on the end of the power supply cable
into the labeled socket on the rear of the IWX/214. Use the
power switch to turn on the unit. Confirm that the red power
light is on.



Start the Software

Click the Windows Start menu, move the cursor to
Programs and then to the iWorx folder and select
LabScribe; or click on the LabScribe icon on the Desktop

When the program opens, select Load Group from the
Settings menu.

From the dialog box, select AddedLabs.iws. Click Load.

Click on the Settings menu again and select the
Ecological Balance settings file.

After a short time, LabScribe will appear on the computer
screen as configured by the Ecological Balance settings.

If you want a digital display of the current dissolved oxygen
concentration and pH level to appear on the Main window
during the recording, open the View menu and select
Voltmeter.

Dissolved Oxygen and pH Electrodes Setup

Plug one end of the DIN-DIN cable into Channel 3 on the
iWorx unit. Plug the other end of this cable into the DIN
connector on the DO2-100 current to voltage adapter.

Attach the cable from the ISE-730 dissolved oxygen
electrode to the BNC connector on the current to voltage
adapter.

Plug the DIN connector on the end of the cable of the ISE-
100 pH electrode into Channel 4 on the iWorx unit.
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Figure GB-3-1: The setup for recording oxygen concentration
levels and pH in a small closed ecosystem using the iWorx/214.

Calibration of the Dissolved Oxygen Electrode

Aim: To calibrate the dissolved oxygen electrode.
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The standard used for calibrating the dissolved oxygen
electrode is the known concentration of oxygen in air-
saturated deionized water. The amount of oxygen that is
dissolved in water is known as its solubility (S) and it is
dependent upon the temperature, oxygen pressure in the
air, and the concentrations of dissolved solutes in the
water. Solubility (S) can be determined by using the
following equation:

S = (al22.414) ((P-p)/P) (r%/100).

In this equation, «is the absorption coefficient of O, at
the temperature, p is the vapor pressure of water at the
temperature, P is the barometric pressure, and r% is the
percent oxygen in the air. For example, at 26°C and
760mmHg and a concentration of oxygen in air of 21%,
S equals:

(0.02783/22.414L/mole)(734.91mmHg/760mmHg)(0.21)
= 252uMO,

Procedure

Place the oxygen electrode in a 250 ml beaker containing
room temperature deionized water. There needs to be
enough water in the beaker to submerge the tip of the
oxygen electrode, and keep its tip away from the stir bar in
the beaker. Place the beaker on a magnetic stirrer. Adjust
the speed of the stirrer so the stir bar is rotating quickly and
evenly.

Click Start on the LabScribe Main window to begin
recording. The trace will eventually reach a stable baseline
towards the top of the recording channel. Type the words
Saturation-DI Water on the comment line to the right of the
Mark button. Press the Enter key on the keyboard to mark
the stable baseline of the recording. This comment marks
the output of the oxygen electrode in room temperature
deionized water that is saturated with as much oxygen as it
can hold.

Obtain a beaker containing zero-percent oxygen calibration
solution at room temperature. Make sure there is enough
solution in the beaker to keep the tip of the electrode clear
of the stir bar.Continue to record as you remove the oxygen
electrode from the deionized water and place it in the
beaker with the zero-percent oxygen calibration solution.

Turn off the magnetic stirrer. Remove the beaker of
deionized water from the stirrer, and place the beaker
containing zero-percent oxygen calibration solution on the
stirrer. Turn on the stirrer and adjust the speed of the stirrer
so the stir bar is rotating quickly and evenly.

The trace will move towards the bottom of the recording
channel. Type the words No Oxygen on the comment line.
Eventually, the trace will reach a stable baseline at the
bottom of the recording channel. Press the Enter key on
the keyboard to mark this new baseline. This comment
marks the output of the oxygen electrode in a room temper-
ature solution that is depleted of oxygen.

Click Stop to halt the recording.



Select Save As in the File menu, type a name for the file.
Choose a destination on the computer in which to save the
file (e.g., a class folder). Click the Save button to save the
file (as an *.iwd file).

Turn off the stirrer. Remove the electrode from the beaker of
calibration solution. Hold the electrode over the beaker used
for collecting waste liquid, and rinse it with deionized water
from a wash bottle. Blot any drops of water from the
electrode and place it in a beaker of deionized water.

Units Conversion

Measure the temperature (°C) in the lab room. Assume the
barometric pressure in the lab room is one atmosphere
(760mmHg) and the concentration of oxygen in the air is
21%. Look up the concentration of oxygen in deionized
water for the temperature in the lab room on Table GB-3-1
on page 3. This value will be used in Step 4 of this units
conversion.

Table GB-3-1: Concentration of Oxygen [02] in
Air-Saturated Deionized Water at 1 Atmosphere.

Temp O, Abs Coeff H,O Vapor Press [O02]
(°C) (a) (p in mmHg) (M)
20 .03102 17.54 284
21 .03044 18.65 278
22 .02988 19.83 273
23 .02934 21.07 267
24 .02881 22.38 262
25 .02831 23.76 257
26 .02783 25.09 252
27 .02736 26.74 247
28 .02691 28.35 243
29 .02649 30.04 238
30 .02608 31.82 234

Select the section of the recording before and after the
oxygen is removed from the deionized water in the
chamber. To view this section of the recording in its entirety
on the same window, it may be necessary to click either of
the Display Time icons in the LabScribe toolbar (Figure
GB-3-2 on page 3).
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Figure GB-3-2: The_LabScribe toolbar.

Click the 2-Cursor icon (Figure GB-3-2 on page 3) so that
two blue vertical lines appear over the recording window.
Place one cursor on the left side of the plateau corre-
sponding to the oxygen concentration in air-saturated
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deionized water. Place the other cursor on the right side of
the plateau corresponding to the oxygen concentration in
the zero-percent oxygen calibration solution (Figure GB-3-3
on page 3).
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Figure GB-3-3: Recording used to convert units of the Y-axis from voltage to
O, concentration (uMolar).

Right-click on the Channel 3 window to open the right-
click menu. Select Units from the right-click menu. Note
that the voltage values for the positions of Cursors 1 and 2
are already entered in the units conversion window.

* Next to the voltage value for Cursor1, enter 0.

* Next to the voltage value for Cursor2, enter the concen-
tration of oxygen dissolved in deionized water at room temper-
ature found on Table GB-3-1 on page 3.

* Next to the unit name, enter pMolarO,.

* Click OK. The units on the Y-axis are equal to the pmoles of
oxygen in a liter of deionized water.

Calibration of the pH Electrode

If the pH electrode is still stored in its bottle of buffer,
remove the electrode from the bottle. Rinse the electrode
with deionized water while holding the electrode over a
1000 ml beaker used for the collection of waste liquids.

Place the tip of the pH electrode in a 250 ml beaker
containing enough room temperature deionized water to
submerge the tip. Keep the electrode in deionized water for
at least ten minutes.

Prepare two 100 ml beakers filled with the pH buffers used
for calibrating the pH electrode. The buffers should be a
room temperature. One beaker is filled with pH 7 buffer; and
the other is filled with pH 4 buffer. Each beaker should be
filled with enough buffer to cover the tip of the pH electrode,
and also allow the stir bar in the beaker to spin without
touching the pH electrode.

Place the beaker containing the pH 7 buffer on the magnetic
stirrer. Carefully place a stir bar in the beaker. Remove the
pH electrode from the deionized water and blot any drops of
water from the electrode. Position the tip of the electrode in
the beaker of pH 7 buffer so that the tip is away from the stir
bar. Adjust the speed of the stirrer so the stir bar is rotating
evenly at a moderate speed.



Click Start on the LabScribe Main window to begin
recording. The trace will eventually reach a stable baseline
toward the top of the recording channel. Type the words
Calibration - pH 7 on the comment line to the right of the
Mark button. Press the Enter key on the keyboard to mark
the stable baseline of the recording. This comment marks
the output of the pH electrode in pH 7 buffer at room
temperature. Continue recording while changing the
beakers of buffers.

Turn off the stirrer and remove the pH electrode from the
beaker of pH 7 buffer. Hold the electrode over the beaker
used for collecting waste liquid, and rinse it with deionized
water from a wash bottle. Blot any drops of water from the
electrode.

Remove the beaker of pH 7 buffer from the stirrer and place
the beaker of pH 4 buffer on the stirrer. Carefully place a stir
bar in the beaker. Position the tip of the pH electrode in the
beaker of pH 7 buffer so that the tip of the electrode is away
from the stir bar. Adjust the speed of the stirrer so the stir
bar is rotating evenly at a moderate speed.

As you continue to record, the trace will reach a stable
baseline toward the bottom of the recording channel. Type
the words Calibration - pH 4 on the comment line to the
right of the Mark button. Press the Enter key on the
keyboard to mark the stable baseline of the recording. This
comment marks the output of the pH electrode in room
temperature pH 4 buffer. Click Stop to halt the recording.

Select Save As in the File menu, type a name for the file.

Choose a destination on the computer in which to save the
file (e.g., a class folder). Click the Save button to save the
file (as an *.iwd file).

Turn off the stirrer. Remove the pH electrode from the
beaker of pH 4 buffer. Hold the electrode over the beaker
used for collecting waste liquid, and rinse it with deionized
water from a wash bottle. Blot any drops of water from the
electrode and place it in a beaker of deionized water.

Exercise 1: Dissolved Oxygen Concentration
and pH in an Aquatic Environment with an
Animal

Aim: To measure changes in dissolved oxygen concen-
tration and pH of water inhabited by fish.

Procedure

Place a magnetic stirrer on or next to the base of a
ringstand. Place 200 mL of fresh pond water, at room
temperature, in a 400 ml beaker. Add a stir bar to the
beaker and place the beaker on a magnetic stirrer. Turn on
the stirrer and position the stir bar to one side of the beaker
bottom.

Adjust the position of the clamps that will hold the dissolved
oxygen and the pH electrodes in the beaker of pond water.

Remove the dissolved oxygen and the pH electrodes from
the beakers of deionized water. Blot the drops of deionized
water from each device. Mount the electrodes on the
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ringstand using the clamps, and position the tips of the
devices in the pond water. Cover the top of the beaker with
plastic wrap to prevent the exchange of gases over the
pond water with those in the environment.

Turn on the stirrer so that the stir bar rotates evenly and
moderately. Wait two minutes before recording the
dissolved oxygen concentration and pH level of the pond
water.

Click Start on the LabScribe Main window to begin
recording. When the recordings on both channels reach a
stable baseline, type the words Pond Water Alone on the
comment line to the right of the Mark button. Press the
Enter key on the keyboard to mark the recording.

After recording at least fifteen seconds of stable baseline on
each channel, type the words Goldfish in Pond Water on
the comment line. Peel back the plastic wrap that covers the
top of the beaker and place a goldfish in the pond water.
Cover the top of the beaker with the plastic wrap, and press
the Enter key on the keyboard to mark the recording. Lower
the speed of the stirrer, if the goldfish seems stressed.

Record the dissolved oxygen concentration and pH of the
pond water for thirty minutes. At the end of thirty minutes,
click Stop to halt the recording.

Select Save in the File menu. Before analyzing the data
from this exercise, complete Step 9 and then proceed
directly to Exercise 2.

Remove the dissolved oxygen and the pH electrodes from
the beaker of pond water. Remove the goldfish from the
beaker and place it in the fish tank. Discard the pond water
and refill the beaker with 200 ml of fresh pond water.
Reposition the electrodes and the stir bar in the beaker of
fresh pond water. Cover the beaker with plastic wrap.
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Figure GB-3-4: The arrangement of the light source, stirrer, electrodes, and
beaker for measuring the changes in the oxygen concentration and pH in a
small closed ecosystem.



Exercise 2: Dissolved Oxygen Concentration
and pH in an Aquatic Environment with a Plant

Aim: To measure changes in dissolved oxygen concen-
tration and pH of water in the presence of an aquatic
plant.

Procedure

At the end of Exercise 1, the electrodes and the stir bar
were placed in the proper positions to make another
recording. Make sure the stir bar rotates evenly and moder-
ately. Wait two minutes before recording the dissolved
oxygen concentration and pH level of the pond water.

Click Start on the LabScribe Main window to begin
recording. When the recordings on both channels reach a
stable baseline, type the words Pond Water Alone on the
comment line to the right of the Mark button. Press the
Enter key on the keyboard to mark the recording.

After recording at least fifteen seconds of stable baseline on
each channel, type the words Plant in Pond Water on the
comment line. Peel back the plastic wrap that covers the top
of the beaker and place a piece of aquatic plant, like
Elodea, in the beaker. Aim a lamp toward the beaker of
pond water containing the plant. Turn on the light to
illuminate the plant material in the beaker.

Warning: To prevent the temperature of the pond water
from rising while the light is on, you may need to place a
large beaker with water, that will act as a heat reservoir,
between the light and the beaker of pond water.

Cover the top of the beaker with the plastic wrap, and press
the Enter key on the keyboard to mark the recording.

Record the dissolved oxygen concentration and pH of the
pond water containing the aquatic plant for ten minutes.

At the end of ten minutes, click Stop to halt the recording.
Select Save in the File menu; then immediately, click Start
to begin recording again. Do not turn off the light at any
time.

Proceed directly to Exercise 3.

Exercise 3: Dissolved Oxygen Concentration
and pH in an Aquatic Environment with a Plant
and an Animal

Aim: To measure changes in dissolved oxygen concen-

tration and pH of water inhabited by a fish in the
presence of an aquatic plant.

Procedure
Type the words Goldfish & Plant in Pond Water on the

comment line. Peel back the plastic wrap that covers the top

of the beaker with the plant. Place a goldfish in the same
beaker. Cover the top of the beaker with the plastic wrap,
and press the Enter key on the keyboard to mark the

Human Exercise Chapter

recording. Lower the speed of the stirrer, if the goldfish
seems stressed.

Record the dissolved oxygen concentration and pH of the
pond water containing the plant and the goldfish for thirty

minutes. At the end of thirty minutes, click Stop to halt the
recording.

Select Save in the File menu.

Turn off the light and carefully move it away from the
beaker. Remove the dissolved oxygen and the pH
electrodes from the beaker of pond water. Remove the
goldfish and the plant material from the beaker and place
them in the fish tank. Discard the pond water. Place the
electrodes in beakers of deionized water.

Data Analysis

Exercise 1: Environment with Animal

Scroll to the section of data recorded during Exercise 1. Use
the Display Time icons on the LabScribe toolbar (Figure
GB-3-2 on page 3) to complete recording from Exercise 1
on the Main window.

Click on the 2-Cursor icon in the_LabScribe toolbar (Figure
GB-3-2 on page 3), so that two blue cursors appear over the
Main window.

Place a cursor on the stable baseline recorded just before
the goldfish was added to the beaker of pond water. Place
the second cursor at the point in the recording that is thirty
minutes after the goldfish was added to the beaker

Click the Analysis icon on the LabScribe toolbar (Figure
GB-3-2 on page 3) to transfer the data between the cursors
to the Analysis window.

In the table across the top of the data display on the
Analysis window, the parameters, Title, Value1, Value2,
V2-V1, and T2-T1 should appear. Any functions that does
not appear in the table can be selected from the list of
functions on the left side of the Analysis window by
holding down the Control key on the keyboard as the name
of the function is clicked (Control-Click).

Place a cursor at the point in the recording when the
goldfish was placed in the beaker of pond water (Time = 0).
Place the second cursor at the point in the recording that is
thirty minutes after the goldfish was placed in the beaker
(Time = 30). Select [Oxygen] on the Value from Ch menu
in the upper left corner of the Analysis window.

Measure the values for the following parameters from the
[Oxygen] channel for the region of data selected:

» Dissolved Oxygen Concentration at Time = 0, which is
Value1 on the [Oxygen] channel.

* Dissolved Oxygen Concentration at Time = 30, which is
Value2 on the [Oxygen] channel.

* Change (A) in Dissolved Oxygen Concentration after 30
Minutes, which is V2-V1 on the [Oxygen] channel.



Record the names and values of the parameters, Title,
Value1, Value2, V2-V1, and T2-T1 for the data of interest in
the on-line notebook of LabScribe that is known as the
Journal. The information can be entered by typing the
names and values directly into the Journal. The measure-
ments can also be entered into the Journal using the
functions in the right-click menu of the Analysis window:

* Place the cursors in the appropriate locations for making
measurements.

» Select Add Title to Journal, from the right-click menu, to
add the names of the parameters measured to a table in the
Journal.

» Select Add Data to Journal, from the right-click menu, to
add the values of the parameters to the Journal.

Record the values for these parameters in Table GB-3-2 on
page 7.

After the recording the data from the [Oxygen] channel,
select pH on the Value from Ch menu. Use one of the
techniques described in Step 8 to record the values for the
following parameters in the Journal:

* pH at Time = 0, which is Value1 on the pH channel.
* pH at Time = 30, which is Value2 on the pH channel.

* Change (A) in pH after 30 Minutes, which is V2-V1 on the
pH channel.

Record the values for these parameters in Table GB-3-2 on
page 7.

Click the Save button to save the file.

Click on the Main icon in the LabScribe toolbar (Figure
GB-3-2 on page 3) to return to the Main window.

Exercise 2: Environment with Plant

Scroll to the section of data recorded during Exercise 2.
Display the complete recording from Exercise 2 on the Main
window.

Place a cursor on the stable baseline recorded just before
the plant was added to the beaker of pond water. Place the
second cursor at the point in the recording that is ten
minutes after the plant was added to the beaker

Transfer the data between the cursors to the Analysis
window.

Make sure the same parameters used in Exercise 1 appear
In the table across the top of the data display on the
Analysis window.

Place a cursor at the point in the recording when the plant
was placed in the beaker of pond water (Time = 0). Place
the second cursor at the point in the recording that is ten
minutes after the plant was placed in the beaker (Time =
10). Select [Oxygen] on the Value from Ch menu in the
upper left corner of the Analysis window.
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Measure the values for the following parameters from the
[Oxygen] channel for the region of data selected:

* Dissolved Oxygen Concentration at Time = 0, which is
Value1 on the [Oxygen] channel.

* Dissolved Oxygen Concentration at Time = 10, which is
Value2 on the [Oxygen] channel.

* Change (A) in Dissolved Oxygen Concentration after 10
Minutes, which is V2-V1 on the [Oxygen] channel.

Use the one of the techniques described in Step 8 of
Exercise 1 to record the values of the parameters in the
Journal.

Record the values for these parameters in Table GB-3-2 on
page 7.

After the recording the data from the [Oxygen] channel,
select pH on the Value from Ch menu. Use one of the
techniques described in Exercise 1 to record the values for
the following parameters in the Journal:

* pH at Time = 0, which is Value1 on the pH channel.
* pH at Time = 10, which is Value2 on the pH channel.

* Change (A) in pH after 10 Minutes, which is V2-V1 on the
pH channel.

Record the values for these parameters in Table GB-3-2 on
page 7.

Click the Save button to save the file.

Click on the Main icon in the LabScribe toolbar (Figure
GB-3-2 on page 3) to return to the Main window.

Exercise 3: Environment with Plant and Animal

Scroll to the section of data recorded during Exercise 3.
Display the complete recording from Exercise 3on the Main
window.

Place a cursor on the stable baseline recorded just before
the goldfish was added to the beaker with the plant and
pond water. Place the second cursor at the point in the
recording that is thirty minutes after the goldfish was added
to the beaker

Transfer the data between the cursors to the Analysis
window.

Make sure the same parameters used in Exercises 1 and 2
appear In the table across the top of the data display on the
Analysis window.

Place a cursor at the point in the recording when the
goldfish was placed in the beaker with the plant and pond
water (Time = 0). Place the second cursor at the point in the
recording that is thirty minutes after the goldfish was placed
in the beaker (Time = 30). Select [Oxygen] on the Value
from Ch menu in the upper left corner of the Analysis
window.



Measure the values for the following parameters from the
[Oxygen] channel for the region of data selected:

* Dissolved Oxygen Concentration at Time = 0, which is
Value1 on the [Oxygen] channel.

* Dissolved Oxygen Concentration at Time = 30, which is
Value2 on the [Oxygen] channel.

* Change (A) in Dissolved Oxygen Concentration after 30
Minutes, which is V2-V1 on the [Oxygen] channel.

Use the one of the techniques described in Step 8 of
Exercise 1 to record the values of the parameters in the
Journal.

Record the values for these parameters in Table GB-3-2 on

After the recording the data from the [Oxygen] channel,
select pH on the Value from Ch menu. Use one of the
techniques described in Exercise 1 to record the values for
the following parameters in the Journal:

* pH at Time = 0, which is Value1 on the pH channel.
* pH at Time = 30, which is Value2 on the pH channel.

* Change (A) in pH after 30 Minutes, which is V2-V1 on the
pH channel.

Record the values for these parameters inTable GB-3-2 on
page 7.

Click the Save button to save the file.

page 7.
Table GB-3-2: Changes in Dissolved Oxygen Concentrations and pH While Organisms Are in a Closed
Ecosystem.
pH Level Dissolved Oxygen Concentration (uMolar O,)
Organisms in Pond Water Rate
Initial Ending Change (A) Initial Ending Change (A) (MO, /min)

Animal, 30 Mins

Plant, 10 Mins

Plant & Animal, 30 Mins

Questions

Exercise 1: Environment with Animal

Do any changes in the dissolved oxygen concentration and

pH of the pond water take place while the fish is in the
beaker?

What are the causes of the changes or the lack of changes?

Exercise 2: Environment with Plant

Do any changes in the dissolved oxygen concentration and

pH of the pond water take place while the plant is in the
beaker?

What are the causes of the changes or the lack of changes?
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Exercise 3: Environment with Plant and Animal

Do any changes in the dissolved oxygen concentration and
pH of the pond water take place while the fish and the plant
are in the beaker together?

What are the causes of the changes or the lack of changes?

If increases or decreases in the oxygen concentration and
pH of large bodies of water (lakes, seas, oceans) took
place, what would be some of the causes of these
changes? Make sure you indicate whether the cause would
create an increase or decrease in pH or dissolved oxygen
concentration.

Appendix
Zero-Percent Oxygen Calibration Solution is

15mM Sodium Hydrosulfite in deionized water.
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